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Basic Praat Tutorials

This is a set of brief tutorials for how to do some basic things with Praat, the great free phonetics
software created and maintained by Paul Boersma and David Weenink. The overall goal is to
help you get oriented to the program in general and some of the more commonly used functions.
This tutorial is mostly geared toward people that are completely new to the program, but there
may be tips that are of some use to experienced users as well. The file is organized into the
following sections:

1. Getting and installing Praat (p. 2)
2. Basic interface (p. 3)
3. Opening Sounds (vs. LongSounds) (p. 4)
4. Working with the Object window (p. 5)
5. Saving files (p. 9)
6. Basic Sound editing (p. 11)
7. Basic recording (p. 21)
8. Opening and running Scripts (p. 27)
9. Appendix A: Exercises (p. 29)
10. Appendix B: Answers (p. 31)

For completeness, this guide was written while | was using Praat version 5.0.27 on a Windows
PC (running Vista, specifically). However, the material covered in this guide is very unlikely to
change much if at all between versions or platforms.

Feel free to distribute this guide (just don’t sell it), but if you do, I’d like to hear about it. I’d
also like to hear about anything you find especially helpful or unhelpful, or if there’s something
else you’d like to see a tutorial for. Just drop me a message at srjacksn@illinois.edu (email
address valid until June 2009, maybe longer).

Also, check (and join) the Praat Users list, at:
http://uk.groups.yahoo.com/group/praat-users/
Happy Praat-ing!

-Scott
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Section 1: Getting and Installing Praat
This is the easiest part!

Just visit http://www.praat.org/ and follow the instructions.

On a Windows machine (at least), the installation is especially “light”, in that it just unpacks as
an executable file that you can run from anywhere on your machine. You don’t even need any
kind of administrator rights to do this (even on rights-crazy Vista), which is especially
convenient if you need to run Praat on a machine that you don’t have those rights for (like a
public computer in a lab, library, etc.). It’s even possible to run Praat from an external source
like a CD, USB drive, etc.

Personally, I like to put the actual Praat executable in my Programs folder, and make a shortcut
to put on my Desktop. Eventually, you will end up with something that looks like this icon to
click on in order to start the program:



http://www.praat.org/
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Section 2: Basic interface

When you start Praat, you will get two windows, the Object window and the Picture window.
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The Object window is really where all the action originates, so this guide deals exclusively with
it and its spawn. The Picture window is really only used when you want to create pictures to

print out or put into other documents. When I am just working with Sounds and so on and don’t
need to print anything, I will often just close the Picture window to get it out of my way, but this

is not necessary, of course.
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Section 3: Opening Sounds (vs. LongSounds)

One basic thing you will probably do frequently is opening sound files to work with. When you
open any kind of file in Praat (except for Scripts, which are covered in Section 8), they are
represented as Objects in the Objects window. As you will discover, there are many kinds of
Obijects that Praat deals with.

The two basic types of sound file Objects are Sounds and LongSounds. One common confusion
for new users is the misconception that Sounds and LongSounds are different kinds of files.
They are not different kinds of files, they are different kinds of Praat Objects. Sounds and
LongSounds are really just different ways to open up any given sound file; you can open the
exact same sound file as either a Sound or a LongSound. The difference between Sounds and
LongSounds is how Praat deals with them and what you can do with them. The rule of thumb is
that you can do more with and to Sound Objects, but because of this, they take more memory,
and so opening very large sound files as Sounds is usually not advisable. How big of a file you
can get away with opening as a Sound will generally depend on your machine and how much
memory it has. Usually you are safe opening files that are a few minutes or less as Sounds, and
if you have a very good machine, you can get bigger ones in.

You can open a variety of file types, including WAV, AIFF, AIFC, and MP3. As of this writing,
Praat cannot open M4P files (like what iTunes uses, for example), but this may change with
future versions (MP3 files were added in June of 2007).

To open a file as a Sound, you select Read - Read from file... and follow your basic file
opening procedure. To open a file as a LongSound, just select Read - Open long sound file...

# | Praat objects E=REEn x| This will open the sound in the Objects
Praat_New [Read) Write Help window, which is the topic of the next
Ohjects: '.ead from file... Ctrl-O .
T - : section.
Read two Sounds from stereo file... .
Read from special sound file » || Go ahead and try opening both a Sound
Read Matrix from raw text fle.. and a LongSound to work with in the
Read Strings from raw text file... . . . .
Read TableOfReal from headerless spreadsheet file.. following sections. (Tip: you can even just
Read Table from table fie.. _ open the same sound file twice, as both
Read Table from comma-separated file... ) )
Read Table from tab-separated file... types of Objects, in case you only have
Read from special tier file... r one sound file on hand.)
‘ -

If you want a sound to play with, you can get “rain_in_spain.wav” from my webpage at:

http://www.psych.uiuc.edu/~srjacksn/rain_in_spain.wav
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Section 4: Working with the Objects window
The Objects window is the center of the action in Praat. It has basically four areas of interest:

e The menus (at the top)

e The Objects list (on the left)

e The context-sensitive command buttons, or Dynamic Menu (on the right)
e The fixed object-handling buttons (on the bottom)

I’1l go over each of these in turn. If you want to follow along with the tutorial, you should try
opening both a Sound and a LongSound to work with. See Section 3 for how to do this.

Object window menus

These are pretty self-explanatory and work basically like you’d expect, if you’re used to
programs with menus. The menus are: Praat, New, Read, Write, and Help.

(8- Praat objects EI@

Praat New Read Write C@e_b
Ohjects’ -

These menus pretty deal with what they say they do, and I’1l direct you to the appropriate menu
elsewhere in this tutorial, so I won’t go through any more details about them here. I just wanted
to point them out, and let you know that when | say Object window menus, these are what I’'m
referring to.

Objects list

This is the box to the left that is your basic “working area.” Praat works with and manipulates
Obijects of various kinds, and if you want to work with some kind of file in Praat, the first thing
you need to do is to get it into the Objects list. So if I follow the instructions in Section 3 and
open up a sound file called sample.wav as a Sound and longsample.wav as a LongSound, this is
what will show up in the list:
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[8 | Praat objects
Praat MNew Read Write
Ohijects: =

1. 5ound sample

2. LongSound longsample

Obijects are displayed first with the type of Object they are, followed by the name of that Object.
So the first Object is a Sound Object called “sample”, and the second is a LongSound Object
called “longsample”, because “sample” and “longsample” are the file names of the sound files I
opened (see Section 3 for the difference between a Sound and a LongSound).

Praat does not complain if you name a bunch of Objects exactly the same name. It also keeps
track of the Objects separately (i.e., changes to one Object do not affect another, even if they
have the same name). This can be useful and convenient at times, but it also can be confusing if
you lose track of which ones are which, so user beware.

Selection

The first step to working with an Object is to select it. The picture above shows the first sound
being selected. You can select any subset of objects by clicking, click-dragging to select a lot of
objects, Shift-clicking to select the endpoints of a continuous set of objects, or Ctrl-clicking® to
add individual (and potentially non-adjacent) objects to the set of selected objects. There is no
way to re-order Objects in the list, without closing and opening them again, so it is likely that
you will eventually want to select a few non-adjacent Objects at the same time, using Ctrl-click.
Other common shortcuts — like Ctrl-A to “select all” — typically do not work.

Context-sensitive action buttons

These are also known as the “Dynamic Menu” in the Praat Help manuals. Probably the first
thing you notice when you click on different Objects is that the buttons that show up on the right-
hand side change. For example, here are the displays | get when selecting a Sound and a
LongSound respectively:

! Ctrl-clicking is a PC/Windows function. This may be known as “Open Apple”-clicking or “context”-clicking for Mac
or other operating systems.
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As you can see, this is what | was referring to in Section 3 about being able to do more with
Sounds than with LongSounds, because you have a lot more action buttons available on the right
side of the Objects window for a Sound (the picture above on the left) than with a LongSound
(the picture above on the right).

The various action buttons represent (virtually) all the commands and operations that you can do
with a given Object. As you can see, there are lots of these, and since this is a Basic Tutorial, we
will not be going over all of them. The goal here is just to point these out to you, and let you
know that when | talk about Action buttons or the Dynamic Menu, these are what I’'m talking
aboult.

Fixed object-handling buttons

The last general region of the Objects window is a set of buttons at the bottom of the window
that do not change, which deal with general things you can do to any Object in the Objects list.

[
Rename... | Copy... |
Inspect | Info |
Fermowe -
4 »
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I won’t go over all the information that you can get with the Inspect or Info buttons (but you are
welcome to check them out), but I will tell you about the others, because they have more general
utility.

Rename...

The Rename... button does exactly that. It opens a new little window (the presence of ellipsis
dots on a button always indicates that it will open a new dialogue box) that lets you change the
name of the selected Object. Important tip: it’s critical to understand that this does NOT
rename the actual file, if the Object represents a file of some kind. This only renames the Object,
which is in the working space of Praat. In order to permanently change the name of the file as
well, you will need to save it with the Write menu (see Section 5 for more details on that).

Therefore, Rename... is mainly useful to help you keep things straight in the working space of
the Objects list, so you can (for example) keep track of all the different modified versions of a
file that you’ve created in a session.

Copy...

This button also does what you’d expect. It makes an exact copy of the selected Object (not
plural Objects— you can only Copy one Object at a time this way) and sticks it on the end of the
list. It opens a window to allow you to rename the new copy right away, to help you avoid
confusion with identical names, but you never have to change the name of the copy, because
Praat doesn’t mind Objects with identical names. Also note, this does not copy the underlying
file that an Object may represent; it only copies an Object in the temporary working space of the
Objects window.

Remove

Finally, the Remove button helps you keep your working space clear by removing objects from
the Objects list. This is something you can do to as many Objects at a time as are selected.
WARNING: if you Remove an Object, it’s gone. There is no recovering an Object, and there is
no “undo” button to take back a Removal. If you want to have access to an Object again, you
MUST save your Object using the Write menu in order to save it to a file that you can reopen
later (see Section 5). Praat WILL NOT give you any kind of “are you sure you don’t want to
save?” warning when you hit the Remove button, so be sure you have saved any changes you
want before clicking Remove.

When closing the entire Praat program (by closing the Objects window), Praat will ask you if
you’re sure you want to quit if you still have Objects in your list. But if you click Remove, Praat
assumes you know what you’re doing, and will not hesitate to close an Object that you haven’t
saved yet.
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Section 5: Saving files

If you’ve read the last part of Section 4, you will know that it is easy to close an Object without
saving it, thus potentially losing your work. If you want to save an object as a permanent file on
your computer that you can later access after closing Praat, you will need to use the Write menu.

Important: dealing with Objects in Praat will make more sense once you start thinking about
them as temporary “working copies” of files that you may have opened or created. These
working copies will disappear the instant Praat closes, and they cannot be accessed by any other
program on your machine. If you want an Object to be accessible after Praat closes, and/or if
you want another program to be able to access an Object, then you must use the Write menu to
save it. This is true even for files already on your computer. The Object that represents any
changes to a file that you already have will be lost unless you Write the new Object to a file.

Fortunately, saving Objects in Praat is very simple. All you need to know is what kind of file
you are trying to save. If you are working with sound files (i.e., Sound or LongSound objects),
you will almost always want to save it as a WAV file, because that is a very common sound file
format that can be opened by most other programs. Many other files in Praat are best saved as
text files. If you are trying to save an Object with a weird type and you’re unsure about the
format, the safest thing to do is to try to save it under one format, and then try to Read that new
file you’ve written before closing out Praat or Removing the original Object. If you can get the
new file back into Praat in the form you want, then you’ve succeeded. If you can’t, then you
should try Writing it as a different format, until you find one that works.

Once you know what kind of format you want, all you need to do is select the Object you want to
save, and choose the appropriate command from the Write menu:

i 1 Praat objects [I=0 [Hom °X)
Praat MNew Read Help
Ohjects: Write to text file... o

1. Sound sample Write to short text file...
2. LongSound longsarn } } .
Write to binary file...

Write to WAV file...

Write to AIFF file...

Write to AIFC file...

Write to Next/Sun file...

Write to NIST file...

Write to FLAC file...

Write to Kay sound file...

Append to existing sound file...

Write to raw 16-bit Big Endian file...
Write to raw 16-bit Little Endian file...

Carvert- |
Filtar - |
Combine sounds - |
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Often, your options will change, depending on what kind of file you have selected. For example,
if you are trying to Write a file from a text-based Object, you will usually not have the option to
Write to WAV file.

Another important tip is that if you change the file name of the file you are Writing in the save-
to-file dialogue window, Praat will NOT append the appropriate extension. Praat only appends
the extension if you leave the file name the same as it is in the Objects window. So either use
Rename before Writing to disk, or remember to add the extension (e.g., “.wav” for a WAV file)
in the save to file window.

Finally, you will usually want to avoid Writing multiple Objects at once, because if you select
more than one Object and select Write, you will end up Writing a single file, with the Objects
appended. For example, if I select both the Sound and LongSound that | have in my current
Objects list and select Write > Write to WAV file..., I will NOT end up saving both files. I will
end up with one sound file that is simply both sound files appended together. Therefore, you
will usually need to Write each file that you want saved separately.

10
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Section 6: Basic Sound editing

Most people using Praat will want to visualize and/or modify sound files in some way. One of
the easiest and most interactive ways to do this is to use the SoundEditor. In this section, I will
go over the following topics:

e Opening a SoundEditor window

e Navigating the SoundEditor

e Changing what information the SoundEditor displays
e Zoom tools

e Selecting and playing sounds and excerpts

e Taking measurements

e Cutting and pasting

e Saving

Note that this section is aimed specifically at the Editor you get with a Sound object. The Editor
for LongSound Objects is slightly different. It has many of the same properties, and the basic
navigation is similar, but many of the options for displaying and modifying the sound are
different. This section will not cover the LongSoundEditor, but many of the tips here will be
applicable.

Opening a SoundEditor window

This is very simple. Just select the Sound you want to Edit (you can only open one at a time),
and click the Edit button in the Dynamic Menu:

7 Praat objects =N EON X
Praat New Read Write Help
Ohijects: Sound help -

1. Sound sample GETTH\
oy —
Play

Dir..

Query - |
Modify - |
Annotate - |
Analyse
Pariodicity - |

Shecthm o |

11
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Navigating the SoundEditor

Here is what a typical Editor window may look like:

& 1. Sound untitled =8 @
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Your display may look slightly different, depending on what your default display preferences
are, and obviously depending on what sound you are editing. The picture above shows the
Spectrogram and Pitch options turned on (with default settings), and everything else turned off.

My purpose here is not to take you through all the details, but I will point out the major
componants of the window. In the later parts of this section, | will refer back to some of these
features in order to get the most basic functions to work.

Menus

[# 1. Sound untitl
File Edit Query View Select Spectrum Pitch Intensity Formant Pulses

0.6933|

0.0

The menus are where most of your options reside for viewing and analyzing the signal. Some of
these functions can be called using the Action buttons in the Objects window as well, but some
of them cannot, and often it’s easier or more convenient to use these menus inside the Editor.

12
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Waveform window
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This window is always present in the Editor, and it displays the raw waveform (i.e., pressure
wave) of the sound. The horizontal dimension is time (from left to right), and the vertical
dimension is air pressure in Pascals (estimated, of course, given the input from microphone, pre-
amp, etc.). If “Show Pulses” under the Pulses menu is turned on, this window will also show a
lot of vertical blue bars, marking where Praat is estimating the primary glottal pulses to be (or
other fundamental wave if the sound is not speech). | rarely have a use for these, so I routinely
turn off Pulses in the menu, to cut down on the visual clutter.

13
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Analysis window
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This window displays other information, parallel to the waveform. The horizontal dimension is
also time, lined up precisely with the waveform time dimension. The vertical dimension depends

on what information is displayed here. In this example, only a spectrogram is displayed. If all

the analysis features are turned off, this window will disappear, allowing the waveform window
to expand to fill the entire space.

Scroll bar
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The scroll bar is your main means to change the view forwards or backwards in time, assuming
your display is not already showing the entire sound. Using the scroll bar is covered later in this

section.

Zoom tools
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These buttons are the primary ways to zoom in or out for different views of the sound. Their use
is covered later in this section.

Changing what the SoundEditor displays

The SoundEditor can display a range of interesting and potentially useful information. The main

way of
menus,

changing what is displayed is by activating the options under the second half of the 10
namely Spectrum, Pitch, Intensity, Formant, and Pulses. These each have a Show...

option that can be turned on and off. Briefly, these are:

Spectrogram (under spectrum): if you don’t know what a spectrogram is or what it is
used for, you should refer to a phonetics text (like Peter Ladefoged’s classic A Course in
Phonetics), or check out my own tutorial on reading spectrograms in Praat (also available
on my website). In brief, it is a graph with time on the horizontal axis, frequency on the
vertical axis, and intensity represented as darkness. There are different ways of
generating spectrograms, and Praat allows for many options, accessible under the
Spectrum menu. Once you learn how to read spectrograms (see another one of my
tutorials for some beginning tips), they are usually the best way to help you segment

15
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speech, if you need to segment utterances at the word level or smaller. Therefore, |
usually have this setting turned on.

Pitch track (under pitch): this is an estimated interpolation of fundamental frequency (see
the Praat Help manual for more on how Praat computes this). Note that because the
method for computing this requires a window of analysis, and this value in the Editor
depends on the visible portion of the Sound, changing the view (for example, zooming in
to a very small time window) can affect the pitch value estimated at any given time point.
My own primary research deals with pitch contours, so | usually have this option turned
on in addition to the spectrogram.

Intensity curve (under Intensity): this is a representation of the decibel (dB) level
throughout the sound. Of course, the actual loudness of the sound depends on how loud
your speakers/headphones are, and perceptual loudness is not purely a function of dB
(also of pitch and other factors; refer to a psychophysics text for more information).
Formants (under Formant): these are a bunch of red dots that represent the estimated
locations of speech formants at regular intervals (the exact settings can be modified quite
a bit). Again, if you’d like to learn more about formants, consult a phonetics text, but
briefly, they represent the peaks of energy in the higher harmonics of a sound. These
energy peaks vary depending on the shape of the resonating tube (i.e., the shape of the
vocal tract), therefore they are acoutic reflections of the changes you make in your vocal
tract when making different speech sounds. In my humble opinion, Praat’s formant
analysis adds more clutter than help when trying to locate formants (since formants are
often visible as dark bands in the spectrogram), so | usually turn this part of the analysis
off.

Pulses (under Pulses): as mentioned above, Pulses are shown as vertical blue bars,
marking where Praat estimates the primary glottal pulses to be. 1 usually turn off this
setting, too.

Scroll bar and zoom tools

These are the basic tools for changing what part of the sound you are looking at. The scroll bar
works exactly as you would expect a scroll bar to work. You can drag the box, click to move the
box, click on the arrows to shift the view slightly, etc.

The zoom tools are also fairly intuitive, and extremely useful and easy to use.

all: zooms out to display the entire sound in the window.

in: zooms the view in, but the zoom is always centered on the currently displayed
window. It does not zoom in centered on, say, the current selection.

out: the opposite of in, also keeping centered on whatever the current view is, not the
current selection.

16
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e sel: perhaps the most useful zoom button, this button zooms the view to precisely
whatever the current selected area is. This is by far the easiest and quickest way to zoom
into a particular desired area.

Selecting and playing sounds and excerpts

Selecting sound segments is fairly straightforward as well. If you click on either the Waveform
window or the Analysis window within the Editor, you will see a dotted line cursor. Thisisa
vertical line that goes through both Waveform and Analysis windows, as well as a horizontal
dotted line in the Analysis window.

At the top of the cursor, Praat gives you the time position of the cursor (in red). In the example
below, you can see that the cursor is at time 1.534960 in the sound. At the bottom, you will see
that there are three layers of time bars. The bottom layer indicates the total duration of the sound
file. In the example below, it shows a total duration of 4.1 seconds. The next layer up indicates
the duration of the current view being displayed, in this case, 1.037685 seconds. In addition, this
layer also displays the beginning and ending times of the current window in blue (here, 1.326151
and 2.363836 seconds, respectively), as well as the durations of the remaining segments on either
side of the current view (here, 1.326151 and 1.736164 seconds). Finally, the top layer, just under
the Analysis window, shows the durations for the segments bisected by the cursor (here,
0.208809 and 0.828876 seconds, respectively).
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The horizontal line on the cursor gives further information, depending on what is being displayed
in the analysis window. In the example above, it is indicating that the horizontal cursor is
positioned at 2697 Hertz (Hz) in the spectrogram.

You can also select a chunk of time, simply by clicking and dragging. This is shown below:
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_all | in | ouwt] sel| | | » [I¥ (Group

You get the same kind of information on the bottom time bars, with the only change being that
because I have selected a segment of sound, the bar just under the Analysis window gives the
durations of all three segments (preceding visible segment, selected segment, and following
visible segment, which here are 0.065 sec, 0.530388 sec, and 0.441975 sec, respectively).

The selected segment duration is also displayed at the top, which is a quick way to check
durations of words, segments, etc. In addition, the top bar also displays the inverse of the
duration as “N /s” (N per second). This can be useful to “manually” check pitch. Just zoom in
close enough so that you can see the individual waveform periods, select one, and you get the
cycles per second, otherwise known as Hz. For example:
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i ' 1. Sound untitled =0 EOR(C5

File Edit Query View Select Spectrum Pitch Intensity Formant Pulses Help

1623378 0.007969 (125.491/ 5) [1631347
0.5818 : ;

-0.5139]

5000 Hzlim

1721 Hz

0 Hz

0.012880 0.007969 i 0.019746
1.610499 |1.61 0499 Visible part 0.040594 seconds 1.651093 2.448907
Total duration 4.100000 seconds
_al|_in | outf sel| 4| m| | IV Graup

| have zoomed in quite a bit here, so that | can see individual glottal cycles, and | have selected
one cycle. The top bar tells me that this is 7.969 milliseconds long, which is a rate of 125.491
per second, a.k.a. 125 Hz.

Precision selection

If you need to be more precise with your selection or cursor position than you can manage with
your mouse, there is an entire Select menu devoted to making your life easier (or at least more
precise). These are pretty self-explanatory, and allow you to specify exact selection positions,
shift the cursor by an exact amount, expand/reduce/shift a selection by an exact amount, etc.

Getting information

Once you have your cursor positioned where you want it (either at a point or covering a
selection), you can get all kinds of information about the sound at that position. In the current
version (5.0.32), this is accomplished by finding what you want in the appropriate menu. For
example, if you want to know the pitch at a given point, or the average pitch over a selection,
look under the Pitch menu.
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Cutting and pasting

One common and simple way to modify a sound is cutting and pasting segments. Maybe you
want to cut “dead” space in the beginning of a recording, or splice a segment out/in (e.g.,
substituting a segment for a cough in a phoneme restoration experiment). The various cutting
and pasting options are available under the Edit menu, but the typical cutting & pasting
keyboard shortcuts work as well (e.g., Ctrl-X to cut, Ctrl-C to copy, Ctrl-V to paste in Windows).
Note that cutting and pasting change not only the overall duration, but also the time labels. For
example, if a consonant burst starts at 1.2 seconds and you cut 0.5 seconds out of the beginning
of the sound, the burst will now be positioned at time 0.7 seconds.

In case you are interested in cutting and/or splicing in the middle of sounds, | would like to also
point out that there are “move cursor/selection to nearest zero crossing” functions in the Select
menu that are extremely helpful for making good-sounding splices (i.e., if you don’t splice at
zero crossings, you are likely to end up with an annoying “click” in the resulting sound).

Saving

Finally, | want to point out that you are able to Write to disk directly from the SoundEditor
window, via the File menu. Specifically, you are able to Write any selection you make to disk.
You can also send selections to the Objects list as a new Sound Object, if you want to work with
that selection before saving it to disk. When you send a selection to the list, you have the option
to “preserve times”, which means the time values are kept from the original sound, as opposed to
starting the selection at zero.

This completes this introduction to the SoundEditor, but it should be clear that | have just
scratched the surface. Check my page from time to time for new tutorials on more specific
topics and uses for the Editor.
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Section 7: Basic recording

This section covers some basic issues in using Praat to record sounds. | will not go over all the
other practical issues of recording (microphone positioning, etc.), but simply assume that you
have a microphone connected to your computer and are ready to record.

The first step is to make sure your recording buffer is big enough for the length of recording you
are making. You should only have to do this once, until you install a new version of Praat. |
suggest making the buffer at least 100 MB, which should allow 30+ minutes of recording at
22050 Hz. If you want to be able to record for longer, or at a higher sampling rate, make the
buffer larger. As far as | can tell, the only reason to worry about the buffer getting too big is if
you have a machine with not much memory and are worried about the machine crashing while
making your 3-hour-long recording. However, if your recording exceeds your buffer size, Praat
will just stop recording when it reaches the end of the buffer, and won’t warn you about it, so be
sure that you know the limits of your buffer before recording that critical data!

To set the buffer, select Praat - Preferences... 2 Sound recording preferences...

|F| Praat objects E@
New Read Write Help

-

Statistics...

MNew Praat script
Open Praat script...

Goodies r

Preferences 4 Buttons...

Quit Ctrl-Q Text reading preferences...
Text writing preferences...
Sound recording preferences...
Sound playing preferences...
LongSound preferences...

Sound recording preferences @

Buffer size (MB): [La0] |

[v Input uses Fortdudio

Help | Standards | Cancel | Apply | 0K, |

Then enter 100 (or whatever number you decide) in the window, and click OK. This preference
should stay set this way until you install a new version of Praat, so you should only have to do
this once.
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When you are ready to record:

In the Praat Objects window, select New = Record mono Sound...

Ty

] /ﬂ Praat objects

Praat Read Write

Ohjects

Record mono Sound...
Record stereo Sound...
Sound

Matrix

Tables

Tiers

Create TextGrid...

Create Strings as file list..

Create Strings as directory list...

Optimality Theory
Articulatory synthesis
Create Permutation...
Polynomial
Multidimensional scaling
Neural nets

This opens the SoundRecorder window.

lﬂ SoundRecorder
File Query

Channels:

Meter

@ Mono
" Stereo

(use Windows mixer

without meters)

Not recording.

Record

(=1 IO8 ~x")

Help

Sarnpling frequency:
(8000 Hz
11025 Hz
12000 Hz
(" 16000 Hz
(@ 22050 Hz
(24000 Hz
(32000 Hz
" 44100 Hz
" 48000 Hz
(" B4000Hz
(96000 Hz
(192000 Hz

Nerre

Select a sampling frequency with the radio buttons on the right (44100 Hz is CD-quality sound,

but 22050 Hz is usually good enough for speech analysis/playback puposes, and will help keep

file size down).
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When ready to record, press the Record button. Sound input should make the green bar in the
middle of the window jump up and down.

Save talist Sawve tolist & Close

If you don’t see the green bar moving, then something is wrong with your sound input. You may
need to check your microphone, connection to the computer, audio drivers, volume settings, etc.
in order to fix the problem. Generally though, if your computer is correctly set up to take sound
input, Praat will get it (caveat: on some machines, you may have to reboot before Praat
recognizes an external mic that you just plugged in).
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If you are getting sound input, avoid the bar getting too high (into the red):

|F| SoundRecorder
File Query

Channels:

=
~

{use Windows mixer

without meters)

Stop

hdeter

fo e ]

Help

Sampling frequency:

NN W el W W W)

Close

Neme:

If the sound input is too high, amplitude clipping will result, which makes the recording sound
crackly. Getting into the yellow is not a problem, generally.

As the recording goes on, the blue progress bar above the Record, Stop, and Play buttons will fill

up.

When you’re done recording, press the Stop button.

=

Cloze |

At this point, your recording is just sitting in the Praat recording buffer, so you should save it
immediately! Starting a new recording will clear this buffer, meaning you will lose any unsaved
recordings. To save from the SoundRecorder window, select File > Write to WAV file... :
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[ 7| SoundRecorder EI@
Query Help
Write to WAV file... _
Write to AIFC file.. ter Sampling freguency:
Wiite to NeXT/Sun file... @ GDEE
Write to NIST file.. s
(12000 Hz
Close Ctrl-W 16000 Hz
without meters) (w 22050 Hz
(24000 Hz
(32000 Hz
Nat recording. (44100 He
(48000 Hz
{ B4000 Hz
(96000 Hz
(192000 Hz
[ [
Fecord | Play MName:
Close Save to list | Save tolist & Close ‘

In the file saving window, you should name the sound what you want, and then append .wav (or
another appropriate) to the end of the file name, to ensure that it will be readable as a WAV file
(or other file) later. In other words, Praat does not usually append the extension when you
change the file name in the file saving window, so you have to do it yourself.

If this is an especially important recording, | would suggest trying to Read the file as a Sound (or
LongSound if it’s more than a couple of minutes!) before closing the SoundRecorder.

Alternatively, if the recording is short and you want to work with it right away without saving it
yet, you can hit the “Save to list” button:

12000 Hz
{uge Windows mixer 16000 Hz
without rmeters) (o 22050 Hz
24000 Hz
32000 Hz
Not recording. 44100 Hz
48000 Hz
" B4000 Hz
86000 Hz
(192000 Hz
Fecord | Play MName:
Close Save to list | Save tolist & Close |
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This will move the new recording into the Objects list as a Sound, with the name shown in the
“Name:” box (which defaults to “untitled”). Important: only use “Save to list” for short
recordings, because it always makes it a Sound object, and if you try to make a very long
recording into a Sound object, you may crash Praat and lose the recording! Finally, when using
the “Save to list” button, just remember that the recording is not saved permanently to disk until
you Write it (see Section 5).
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Section 8: Opening and running Scripts

The final section of this basic tutorial deal with running Scripts, which are an immensely useful
and powerful tool for getting the most out of Praat. The Praat Help manual has a very good
introductory tutorial for learning how to create your own scripts, and expanding on that is
beyond the scope of this introduction. My purpose here is just to orient you towards how to use
scripts that other people have used. This section covers these topics:

e What is a Script?
e How to open Scripts
e How to run Scripts

What is a Script?

A Praat script is simply a set of commands and functions that someone has packaged into
something that can be run all at once. It is an extremely useful way to automate simple,
repetitive tasks in Praat. It is written in a programming-like language, but this language is very
simple and easy to learn. However, you do not need to know anything about the scripting
language to effectively run a Script.

How to open Scripts

This is worth mentioning simply because opening Scripts is different from opening any other file
in Praat. Instead of using the Read menu, you use the Praat menu in the Objects window, then
select “Open Praat script™:

| ' Praat objects =nlEl )
Mew Read Write Help
Statistics... | =l

Mew Praat script
Open Praat script...

Goodies 4
Preferences 4
Quit Ctrl-Q

Then you select the file to be opened as usual, and the script will open in a new window.

Sometimes script writers will put comments at the top of their script in order to explain how to
use it or how it works. This can be very helpful if you are trying to run a script that you found
elsewhere, like on someone’s website. If you so desire, you can edit the script in this new
window, but you should not need to in order to run it.
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How to run Scripts

Once the Script is open, this is very easy! Simply select Run = Run, or hit Ctrl-R:

|& 1| untitled script (modified)

File Edit Search

# this iz a 3illy 3 Run

clearinfo Run selection

Ctrl-R

E=HECE

Help

X
v

-1

Z=K+Y

print "z'

-

The script will then run, and do whatever it’s written to do. This may open up additional
dialogue windows, create new sounds, produce analyses, etc. etc.

When you are done using the Script, you can simply close the window, or it will close by itself

when you quit Praat.

This concludes this set of Basic Praat Tutorials. | hope this has been helpful and/or clear. Good

luck!

If you want to try out some things that | have talked about here, I have included a set of
Exercises along with the answers in the following Appendices.
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Appendix A: Practice Exercises

Exercise 1: Opening, changing, and saving a sound

Open a sound file that you don’t care about messing up (just in case something goes horribly
wrong ©).

Open the file both as a Sound and a LongSound.

As a Sound, make it go in reverse by selecting the Sound, clicking the “Modify” button in the
Dynamic Menu, and selecting Reverse. Play the Sound to confirm that the reversal worked.

Use the Rename... button to rename this Sound to “backwards_[original sound name]”
Write this Sound to WAV file (or another format, if you prefer).

Close Praat, and confirm that you have successfully modified the original Sound, saved it to disk
under a new name, and left the original sound file intact.

Exercise 2: Taking measurements with the SoundEditor
Download “rain_in_spain.wav” from my website:
http://www.psych.uiuc.edu/~srjacksn/rain_in_spain.wav

Open it as a Sound Object in Praat, and open it in an Editor, and provide the following
measurements:

Total sound duration

The pitch value for the point at time 0.40000 seconds.

The average pitch for the selection from 0.125 sec to 0.478 sec
The maximum pitch for that same selection

The time point of the maximum pitch for that selection

The average intensity (in dB) for the same selection

-~ Do 00 oW

Exercise 3: Measuring pitch “manually”
Download “rain_in_spain.wav” as above.
Open it in an Editor.

Zoom to view the time span 1.715 sec to 1.755 sec.
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Select time 1.7246 to 1.7421, and notice how this selection encompasses a little more than two
periods. That is, you can see a general repetition of the waveform, and it goes through a little
more than two cycles in this selection.

Find the zero crossings at the beginning and end of the first period in the previous selection.
Aim for the zero crossings just after the biggest negative “valley” in the waveform.

Select the time between these zero crossings using the precision selection method (i.e., the Select
menu).

What is the length of this segment? What is the “pitch” of this segment in Hz (assuming of
course that it repeats at this rate).
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Appendix B: Practice Exercise Answers

Exercise 1: Opening, changing, and saving a sound

The “answer” is just whether you accomplished the objective without messing up your original
sound file.

Exercise 2: Taking measurements with the SoundEditor

3.34 seconds
154.14 Hz
137.34 Hz
154.44 Hz
0.406681 sec
76.43 dB

D 00T

Exercise 3: Measuring pitch “manually”

Here’s the view you should have started with:

(@ 2. Sound rain_in_spain = H,E\ [}37\
File Edit Query View Select Spectrum Pitch Intensity Formant Pulses Help
1.724600 0.017500 (57.143 / 5) 1742100

0.304|

-0.2824]
5000 Hz,

0 Hzf8

0.017500
1715000 [1.715000 Visible part 0.040000 seconds 1755000 1587268

Total duration 3.342268 seconds

Lalt|_in | out] sel| | I [V Group
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I picked the zero crossings at time 1.725730 and 1.733566, using the “Move cursor to nearest
zero crossing” option under the Select menu and recording the precise time values on both sides
of the period, and then using the Select... tool to select precisely the time between these two

points.

lﬂ 2. Sound rain_in_spain

File Edit Query View[SeIect Spectrum Pitch Intensity Formant Pulses

0.304]

-0.2464
-0.2624|

5000 Hz|

Select...

Move cursor to start of selection
Move cursor to end of selection
Move cursor to...

Move cursor by...

Move start of selection by...
Move end of selection by...
Select earlier

Select later

Move start of selection left
Move start of selection right
Move end of selection left
Move end of selection right

Move start of selection to nearest zero crossing
Move cursor to nearest zero crossing
Move end of selection to nearest zero crossing

Up

Down
Shift-Up
Shift-Down
Ctrl-Up
Ctrl-Down

Ctrl-,

Ctrl-0
Ctrl-.

[# 1 2. Sound rain_in_spain
File Edit Query View Select S

pectrum Pitch Intensity Formant Pulses

=1 IoE X

Help

0.304]

1725730 0.007836 (127.616 7 5) ___|1.733566

1.715000 [1.715000

Visible part 0.040000 seconds

1755000 1587268

Total duration 3.342268 seconds

ot |_in ] ou] sel] 4|

Ii

| v Group
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Given these zero crossings, the length of the period is 0.007836 seconds, which gives a “pitch”
of 127.616 Hz.

| am putting “pitch” in scare quotes, because it is slightly nonsensical to talk about the pitch at a
single point in time, or even over a single period, since pitch is probably not perceived over a
single period. But assuming the waveform period repeats at the same rate as this selected period,
this single-period “pitch” would be accurate.
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